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What is dWValidator? 
dWValidator is a tools package used to automatically validate digital objects, such as image files, PDF 

files, XML data (METS, ALTO) and other derivatives. Validation is the process of checking if something 

satisfies certain criteria. Examples would include checking if a statement is true (valid), or if data is 

compliant with a certain standard. For digital objects there are many variations for output data. 

The validation is typically performed in two steps: Automated validation and Manual validation. 

• The Automated Validation is checking all files for specific parameters and integrity and ensures 

all data is of consistent quality. 

• The Manual Validation is performed by operators using the Validator user interface, checking 

samples for image quality, meta data, text quality or other parameters that cannot be validated 

by a machine (subjective criteria). 

The dWValidator software provides reports and statistics of the results. 

The dWValidator's benefits: 

• Independent quality assurance tool 

• Detailed reporting as XML, HTML, PDF, custom format 

• Integrates customizable automated tests 

• Integrates customizable selection for manual QA data set 

• Specific tools for manual QA (combined views, color picker, measurement tools, histograms, 

etc.) 

• Multithread testing for higher performance 

The dWValidator is developed as a QA tool for digitization services in order to: 

• Reduce QA costs 

• Avoid human errors from manual QA process 

• Merge different tools we use for QA 

• Ensure 100% accuracy for measurable properties 

• Create reports to be submitted with deliveries 
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Get started 
Basic workflow 

 

The standard workflow for the validation process consists in 4 stages: 

1. Create / Edit the project configuration that will be used. 

 With Configuration Manager you can create and edit project configurations. Use this 

application to group files on specific categories (docblocks), create automatic and manual tests 

and define the manual QA selection rules. For more details, see Configuration Manager Help. 

2. Start the import and validation of the batches. 

In Control Center you simply add the path of the batch, the destination path and project 

configuration that will be used and trigger the validation process. For more details, see Control 

Center Help. 

3. Check the progress of the automatic validation. 

The dWServices are background services – they perform the tasks automatically, without any 

user interaction. The services will automatically copy the batch to the destination path and 

create the validation tasks. These tasks are also automatically processed by the services and the results 

are added to the Database. For more details, see dWServices Help. 

4. Check the results and statistics. 

Use dWValidator to check the automatic tests results and statistics. There are detailed reports 

on every level – from batch level to file level – that can be used to check what tests failed and 

why. The file itself can also be inspected to double check the results. The same application can be used 

to perform the manual tests, each file type having a set of tests to be performed, defined in project 

configuration. For more details, see dWValidator Help.  

dWValidator

•Check the validation 
results

•View statistics 

•Perform ManualQA

dWServices

•Automatically copy 
the batches

•Run the automated 
tests

•Generate the 
validation results

Control 
Center

•Start the import and 
validation of the 
batches

Config 
Manager

•Create / Edit project 
configuration

file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
file:///D:/manuals_updates/all%20manuals/Validator/Control%20Center%20and%20dWServices.pdf
file:///D:/manuals_updates/all%20manuals/Validator/Control%20Center%20and%20dWServices.pdf
file:///D:/manuals_updates/all%20manuals/Validator/Control%20Center%20and%20dWServices.pdf
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dWValidator 
With dWValidator you can check the validation results and statistics, inspect the validated files and 

perform manual tests. 
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The interface 

Window styles 
dWValidator is built in the same style as Configuration Manager, so you can customize the windows 

(resize, reposition, close or hide). The interface has the same two basic window types: tool window 

(Explorer tree, Toolbox window, Tasks list window) and document window – or view (Image windows, 

XML windows, PDF windows, reports windows, statistics windows…).   

Tool windows can be resized and dragged by their title bar, but their docking positions are more 

restrictive and they cannot be left floating. Document windows can be dragged by their tab and docked 

anywhere, they even can be left floating. 

Docking 
While dragging a window, check for a dock indicator where it can be dropped and hover that indicator. A 

blue highlighted area will appear, showing you where the window will be docked if you release the 

mouse button now.  

 

Example of how to dock Toolbox under Explorer: 
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Because dWValidator has multiple document windows for each file, there are numerous ways to arrange 

them on screen, or even leave them floating on a second screen.  

 

To move a dockable window without snapping it into place, hold the Ctrl key while you drag the 

window. This will prevent the window to dock to a position, leaving it floating (if the window allows it). 

 

Closing and auto-hiding 
Tool windows have an “auto-hide” feature, which will make a window slide out of the way when you use 

a different window. To hide a window, press the “pin” button from the title bar: 
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When a tool window is auto-hidden, its name appears on a “hide bar”, a tab on the edge of the 

application. To use that window again, point to the tab so that the window slides back into view. 

 

When the mouse cursor leaves the window area, it will automatically hide again. To make the window 

active again (stop it from auto-hide), press the “pin” button. 

Any window from dWValidator can be closed by clicking the X on the upper right corner of the title bar 

(or tab), except the Explorer tree – this window doesn’t have a close button.  

If a tool window is closed or not displayed, it can be opened from the View menu: 

 

 

Save the windows layout  
When first opening dWValidator, the window layout is default: Explorer on the left side, all document 

windows are docked as tabs on top of each other. You can change the way the windows are arranged 

and the new layout will be automatically saved when you close the application.  

Because each docblock has its own number and type of document windows (views), it’s possible to 

arrange the views differently for each docblock. The application will save the new layout for each 

docblock, and when you reopen the application, the views will be in the same place.  
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Unlike tool windows, document windows don’t have a menu entry to display them again once they are 

closed. If you close a document window, this will remain closed. To reopen them, select Reset view 

entry from the View menu: 

 

This will reopen all closed windows for the selected file type, but will also reset the layout. You can use 

Reset view also for returning to the default window layout.  

To prevent layout changes made by mistake, you can enable Lock Layout entry from Tools menu: 
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Another possibility to reset the layout and reopen closed views is Close all option from File menu: 

 

This action will close all the views of the current selected node from Explorer. Select another node to 

have all the views displayed again with the default layout. 

If you are interested only in one view for a certain file type, you can use Close all but this one option 

from File menu: 

 

This action will close all the views, except the selected one, and will keep this style of display for all files 

of this type. It can be very helpful when performing manual QA – keep only the file displayed, there is no 

need for statistics or reports view (they are not relevant for the process). 

There is also the option to close only one view, by selecting Close option from File menu: 
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Opposite to Close all but this one, this action will close the current selected view.  

All the Close actions will apply only to document windows, tool windows will not be affected by these. 

Also, tool windows are not influenced by Reset view action either. Closing and opening tool windows is 

strictly done with X button and menu entry. 
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Cache clearing 
In case the location where the low-resolution images will be kept is the local temporary folder, on the 

status bar is displayed a progress bar representing the amount of space occupied by the cache files. You 

can configure the total amount of space used by dWValidator in Options dialog (for more details, see 

Cache settings Help). 

 

If you cannot see the status bar, click on Status bar option from VIEW menu to enable it. 

When inspecting batches and documents in dWValidator, low-resolution images are regularly created in 

advance and saved on disk to make Thumbnail view (for more details, see Thumbnail view Help) or the 

navigation between files a lot faster. Once created, they are used every time that batch is opened. They 

are automatically deleted when the batch is deleted, accepted or rejected.  

You can, however, manually delete low-res images, especially when you have set a smaller storage 

space for cache. The progress bar will indicate the percentage of space occupied and will gradually 

change the color when approaching the maximum storage set: 

- Smaller than 50% - green 

 

- Between 50% - 75% - yellow 

 

- Between 75% - 90% - orange 

 

- Over 90% - red  

 

To delete the cache files, click on Clear cache button next to the progress bar. This will open a dialog 

where, based on occupied space and Clear cache percentage, you can free up space. 
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In the basic version of the dialog, an algorithm is applied to first determine if any files are deleted. To do 

this, it checks: 

(100 – Clear cache percentage) < current space used 

If this is not true, then no low-res images will be deleted. Otherwise, the oldest cached files are deleted 

– the files of an entire document at a time.  

The advanced version of the dialog can be activated by clicking Advanced button. This will extend the 

dialog, showing a list of batches for which low-res images are available on disk. 

 

The batches also contain details like batch name, status and the size on disk of its low-res images. You 

can select the batches you no longer use and delete the low-res images for it. 
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Users 
dWValidator requires credentials for performing ManualQA and setting the status of a batch. For 

ManualQA, the necessary right is “User can perform manual QA” and for the batch status, the right 

necessary is “User can accept or reject batches”.  

Log in / out  
You can log in using Log in option from USER menu: 

 

This will prompt you with a dialog for entering your credentials: 

 

Error messages will appear if the user name you’re trying to log in with doesn’t exist or the provided 

password is incorrect.  

Once you’re successfully logged in, your username will appear in the application title bar. 

 

You can always log out from the application by selecting Log out option in USER menu: 

 

 

In case you have a batch opened when logging out, the exploration will be closed. 
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Changing your password 
You also have the option to change your password by selecting Change password from the same menu. 

 

This action will open a dialog where the old password is required, the new password and a confirmation 

for the new password: 

 

The only password restriction is that it must contain at least 5 characters. 
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Open a batch 
To view validation results of a batch, press Open button  from the toolbar or select Open exploration 

entry from the File menu. This will open the Batches dialog, from where you can choose the desired 

batch: 

 

The dialog has a Projects filter that you can use to narrow down your search: 

 

There is also a filter for Manual QA1 (for more details, see Open a batch for Manual QA Help), that will 

display in the batches list only the batches that are marked for Manual QA (for more details, see Define 

manual QA selection Help). 

                                                           
1 The button is enabled only if you have the Can perform manual QA right 

file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
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The next button is Delete batch (for more details, see Deleting Batches Help). If you have enough rights, 

you can use it to delete one or more batches you no longer need. To delete multiple batches at a time, 

selected them using Ctrl or Shift keys. 

 

You can search for a certain batch by its ID, using the search box: 

 

After typing a batch ID, press Enter key – the batch will be highlighted in the list. If the batch is not 

available, a message will be displayed. 

The batches list will display all the batches available for selected filters. For each batch, its details will be 

filled in the list’s columns: 

 

- Batch ID – is an ID automatically assigned to the batch when it is added to Database 

- Project name – the name of the project that the batch belongs to 

- Batch name – the name of the batch, given by the folder name that was imported 

- Status – displays the current status of the batch 

- Path – is the storage path of the batch 

- Import date – the date when the batch was imported in Database 

If you can’t find the batch you’re searching for, check in Control Center if all the validation tasks were 

performed correctly (if there are no failed tasks) – for more details, see dWServices Help. Another 

possible cause is the project’s availability – check Configuration Manager to see if the project is hidden 

(for more details, see Handling projects Help). 

Once you find the desired batch, press Open button or double click it – this will populate the Explorer 

tree with the elements of the batch: 

file:///D:/manuals_updates/all%20manuals/Validator/Control%20Center%20and%20dWServices.pdf
file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
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The font color of the nodes in tree are set based on the validation results. If everything is green, it 

means that all the files passed all the defined tests successfully. For more details on the colors used, see 

Automatic tests results Help. 

To close an exploration, select Close Exploration option from FILE menu. 

 

Open a batch for Manual QA 
In the Batches dialog, click Manual QA filter to see the batches marked for manual QA: 

 

If the button is not available for you (disabled), it means that you’re either not logged in or you do not 

have the Can perform manual QA right enabled. 

If you can’t find the batch you’re searching for, check the configuration for manual QA selection (see 

Define manual QA selection Help). It might be that you haven’t enabled manual QA for your project or 

dWServices haven’t finished processing (see dWServices Help). 

Once you find the desired batch, press Open button or double click it. This will open a new dialog, an 

additional filter for the Manual QA process: 

file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
file:///D:/manuals_updates/all%20manuals/Validator/Control%20Center%20and%20dWServices.pdf
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Set the filters to your needs (for more details, see Performing manual QA Help) and press Confirm 

button.  

 

Deleting batches 
If Delete batch is not available for you (disabled), it means that you’re either not logged in or you do not 

have the Can import batches right enabled.  

To delete a batch, select it from the list and press Delete batch button. A warning message is display, to 

announce you that all objects and test results related to this batch will be deleted too.  

 

In case the batch (or one of the batches) you selected for deleting is opened by someone else on 

another machine, the delete operation will not be completed. A warning message will be displayed, 

letting you know that someone is using it. 
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The delete operation is done in background, so you are free to use Validator while the selected batches 

are deleted. However, the application cannot be closed until the deletion is completed. Trying to close 

Validator will display this message: 
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Explorer 
Explorer window is the most restricted window of dWValidator – it cannot be closed and can be docked 

on the left or the right side of the application.  

It contains a tree-like structure of a batch, having as root node the Project name: 

 

A document will have the structure as it was defined in Configuration Manager. For more details, see 

Define the exploration rules Help. 

 

file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
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When selecting a node from Explorer, the right-hand side is updated, displaying all views of the node, in 

the default (or custom) layout. For more details, see Save the windows layout Help. 

Context menu actions are available for some of the tree elements: 

- For batch and documents: 

o Open location – that will open the selected node as a folder using Windows Explorer (or 

your default application) 

 
o Re-run validation – will generate the validation task for the selected document / batch 

that will be processed by dWServices. All the automatic tests will be run again and when 

the task is finished, the new results will be added. In case the option is disabled, either 

you don’t have the Can import batches right, or Validator configuration is not correct (in 

this case, contact dWSupport). 

- Files have Open… action in context menu, that will open the selected file using the external 

application you have set for that file type and Open location that will display the folder 

containing the file using Windows Explorer (or your default application) 

 

The nodes of the tree have different font colors, based on the results on the validation or manual QA 

process. For more details, see Automatic tests results Help and Manual tests results Help. 

Opening a batch in Manual QA mode (see Open a batch Help) will display additional buttons on top of 

Explorer tree, used to filter the nodes of the tree. For more details, see Explorer for Manual QA Help. 
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Explorer for Manual QA 
When opening a batch in manual QA mode, the Explorer tree is populated with the elements you 

selected. On top of the Explorer, there are filter buttons available, so you can view exactly what you are 

interested in. By default, all filters are enabled. 

 

All  – shows all the files and enables all the filters 

Not visited  – displays only files that haven’t been at least viewed (displayed) by the operator. This is 

also the default status for all files, when opening the batch for the first time. 

Visited  – displays only the files that where viewed by an operator, but without modifying any test 

result. This status is automatically set when the operator selects another file. 

OK  – displays the files that have at least one test with status “OK”, no matter the statuses of the 

other tests. 

Failed  – displays all the files that have at least one test with status “Failed”, no matter the statuses of 

the other tests. This includes both “minor” and “major” types that are set for the tests (for more details, 

see Add manual QA tests Help). 

For review  – displays all the files that have at least one test with status “For review”, no matter the 

statuses of the other tests. 

Refresh  – refreshes the tree and re-applies the selected filters.  

While navigating the files and changing the statuses of tests, the colors of the tree elements changes 

based on the “worst status” set for that file. The “severity rule” of the status is: 

Not visited < Visited < OK < For review < Minor test failed < Major test failed < Test crashed. 

The colors for the tree elements are: 

- Gray – for Not visited 

- Light green – for visited 

- Green – for OK 

- Blue – for Review 

- Orange – for Minor test failed 

- Red – for Major test failed 

- Magenta – for Test crashed 

 

file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
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Virtual document 
In some cases, the provider will deliver additional files for the batches, alongside the documents. These 

files can be checksums, target files etc. 

If the configuration for the project includes these files also (for more details, see Batch configuration 

Help), a separate document will be created, that will contain the extra files. The name of this “virtual” 

document will be “Batch_[name of the batch]”. 

 

The virtual document behaves the same as any document: it is split in docblocks that contain the files, 

has reports and statistics and all other features of a normal document (for more details, see Explorer 

Help). 

  

file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
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Performing manual QA 
When you open a batch to perform manual QA (see Open a batch for Manual QA Help), you need to set 

your selection filters in the Manual QA Selection dialog. 

You first select the Level of the batch on which to do the manual tests. There are 3 levels available: 

Batch, Document, Docblock.  

After you’ve made the selection, the tree will be filled with the elements. Some of the content you 

select however, might not be displayed, due to the manual QA selection configuration. For example, if 

you use a script to mark for manual QA only certain files of a docblock, only those files will be displayed, 

not the entire content of the docblock.  

 

Selection levels 
Batch 
This will open all the content of the batch and will give you access only to the manual tests defined at 

batch level and virtual document. For more details, see Virtual document Help. 

 

Document 
This option will “lock” only the documents you select in the Documents list, together with all their 

contents. No other person will be able to open any of the selected documents at the same level, but 

they will have access to the documents you haven’t select. The virtual document will not be available on 

this level – it is available only on batch level. 

Selecting this level will give you access to manual tests defined at document level.  
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In the screenshot above, when pressing Confirm, the tree will contain only the two selected documents, 

with their entire content. 

Docblock 
Selecting Docblock as level will give you the option to choose which docblocks of which documents you 

want to manually tests. The “lock” will be applied only to the selected docblocks of the selected 

documents, leaving the rest available for other users. 
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In the screenshot above, after pressing Confirm, the tree will contain only the selected document, 

having only the three selected docblocks available. 

The name of the user will appear under Locked by column in case a document / docblock is already 

locked by someone else. 
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Task list 

 

The Task list is automatically opened in Manual QA mode, but can also be opened from View menu, by 

selecting Task list: 

 

The list will open to the last saved position for that docblock, or on the top part of the application, if it’s 

the first time you open it. The docking positions available are Top and Bottom, but the list can also be 

hidden or left floating. 

Task list has four buttons on its toolbar: 

 Status: OK – Use this button to mark a test as passed 

 Status: Failed – Used for marking tests as failed 

 Status: For Review – This can be used as a status for tests that you are not sure whether they are 

passed or failed, and you need someone (a project manager) to have a second look over the file. 

You (or the project manager) can later reopen the batch and use the Explorer filters to recheck the files 

with status For Review. For more details, see Explorer for Manual QA Help. 

 Print screen – creates a screenshot of the application and displays it into a new window, where you 

can crop and save it. 
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Use Crop  button to crop only the portion of the screenshot that you’re interested in. If you’re not 

satisfied with the cropping, you can restore the initial screenshot using Restore button. Once you are 

done with the changes to the screenshot, press Save  to save the screenshot and close the window.  

The relative path of the saved image will be added to the selected test from Task List. 

Under the toolbar you will find the list of tests that were defined for the selected file in Configuration 

Manager (for more details, see Add manual QA tests Help). 

 

The information available are: 

- The three-letter code defined for the test 

- The test information 

- The severity of the test 

- The current status of the test 

o If is the first time displaying the file in ManualQA mode, the status will be empty 

o If the file has been previously displayed, but no manual change of a test’s status was 

done, the displayed status will be “visited” 

file:///D:/manuals_updates/all%20manuals/Validator/Configuration%20Manager%20-%20User%20guidelines.pdf
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o After the status is manually changed, the status selected by the operator will be 

displayed: either “OK”, “Failed” or “For review”. 

- Screenshot relative path 

- Which user checked the test and when. 

Depending on the selection level you’ve made (for more details, see Selection levels Help), only some 

tests will be displayed in Task list. 

For example, choosing Batch as the selection level will only give you access to the manual tests defined 

at batch level and virtual document. Even though you have access to all the files of the batch, the tests 

will not appear in the Task list. 

 

Manual QA history and screenshot options 
You have the option to view the history of a test or of the file that you’re currently inspecting. You can 

use this history to view which user changed something and when. 

Right clicking on a test from Tasks list will open a context menu: 

 

• Entry history – displays the history (all the changes made) of the selected test: 

 

• Object history – displays the history of the current file (the history of each test): 
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• Open screenshot – will open the screenshot attached to the selected test with the default 

application for viewing pictures 

• Open folder – opens the folder where screenshots are stored 

• Remove screenshot – removed the screenshot from the selected test and deletes the screenshot 

file. 
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Toolbox 
The Toolbox is a tool window that can be opened from View menu: 

 

 

Tools available for images 
The buttons available on the Toolbox will appear when the selected view is an image: 

 

Zoom actions 

 Lock zoom - will disable Zoom in, Zoom out, Fit to screen and Original size buttons and will keep the 

same zoom level existing on the current image onto other images. 

 Zoom in - zooms in on the selected image 
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To zoom in on a specific portion of the image, you can create a “zoom rectangle” using right-click mouse 

button. To do this, right-click and hold, and move the mouse cursor – a rectangle will be displayed over 

the image, highlighting the area that will be zoomed. 

 

When the image is zoomed in, the image can be moved using the scroll bars or by holding down the 

CTRL key and using click-and-drag with the mouse. 

When holding down CTRL key, the mouse cursor will change into a hand  to let you know that you 

can move the image. When you click the mouse, the cursor will change into a closed hand , meaning 

you can start moving the image. 

 Zoom out - zooms out of the selected image (scroll wheel down) 

 Magnifier – opens a new panel under the image view where the portion of the image that is 

currently hovered with the mouse is displayed at its original size.  
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 Fit to screen – will set the necessary zoom level on the selected image, so that it will fit in the image 

view, no matter the dimensions of it 

 Original size – will zoom in on the image to the level where the image will be displayed at the 

original size 

Grid 
Pressing the button will open a panel under the button in Toolbox.  

 

In the panel, you can select the color and size of the grid. Pressing Show grid button will display a grid 

over the image, having the distance between the lines as selected in the Grid size box. The grid size is 

not affected by the zoom level of the image. 
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Highlight exposure 
It opens a panel under the button in Toolbox.  

 

The panel contains a button to select the mask color, that opens a color dialog to select the desired 

color.  
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Two sliders are available to set the “exposure range” – two gray colors, a lower limit and an upper limit. 

After setting these limits, use “Show exposure” button to highlight the pixels of the image that have the 

RGB in that range. 

For example: setting the lower limit to 245 and the upper limit to 255 will highlight all pixels that have 

the RGB value between (245, 245, 245) and (255, 255, 255) – very light colors.  

The same can be used to highlight dark zones – just set the limits very low (for example: lower limit: 0 

and upper limit: 10). 

Color picker 
It opens a dialog under the button inside the Toolbox and changes the mouse cursor into a cross. Click 

anywhere on the image and a red circle will appear. The contents of the dialog will be filled with a color 

sample, the RGB code of the color and the XY position of the point inside the image. 

 

You can select a radius for the color picker, which will calculate the average color around the clicked 

point by the selected radius.   
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To close Color picker, click again on its button or right click anywhere on the image. 

Histogram 
It opens a panel with four boxes. Each of the boxes contains a different histogram: first one is for Red 

color, second one for Green color, third one is for Blue color and the last one is for Color brightness.  

 

For the Color brightness histogram, the formula used is: 

((Red value X 299) + (Green value X 587) + (Blue value X 114)) / 1000 

The histogram is automatically closed when selecting a different image from tree. The reason is that 

calculating the histogram might take a long time, especially on large images. 

Measure 
It opens a dialog under the button in Toolbox and changes the mouse cursor to a cross. When first 

opened, a green rectangle will be anchored to the top left corner of the image; this rectangle 

automatically changes it shape and size when moving the mouse, to follow the cursor. 



dWValidator Help  39 

 
 

 

The values from the dialog are automatically updated whenever the mouse is moved. They display: 

- The current XY position of the mouse 

- The width and height of the rectangle  

- The distance between the point where click was made and current mouse position 

- The angle difference between the two points. 

To close Measurement tool, click again on its button or right click anywhere on the image. 
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Tools available for Thumbnail view 

 

For Thumbnail view, in Toolbox you have available a slider that you can use to control the size of a 

thumbnail. Depending on the level of details you’re interested in, you can increase or decrease the size 

of the thumbnail.    
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Tools available for ALTO – Text and Image view  

 

When the selected view is Text and image view for an ALTO file, the Toolbox content is changed, 

displaying controls helpful for OCR quality check: 

 

While checking the correctness of the text, you can count the errors found by modifying Errors count 

control. In Total chars control are displayed all the characters of the current image. You have the option 

to include the spaces as characters or not. Based on the number of errors found, the OCR quality is 

automatically calculated, using this formula: 

(1 – Errors count / Total chars) * 100 
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The precision set for the OCR quality is 3 digits. 

 

The Vertical Text checkbox changes the text orientation in the zones table. This can help you visualize 
vertical oriented texts, such as Chinese or Japanese.  

 

 



dWValidator Help  43 

 
 

Tools available for ALTO – Articles view  

 

When checking Articles view, a new group appears on the Toolbox: Articles options.  

 

The article categories are automatically detected and, for each category found on the displayed page, a 

button for color selection is displayed. There is also a slider available to control the thickness of the 

outlining of a zone.  



dWValidator Help  44 

 
 
All the options you select (article category color, outline thickness) are saved so you don’t have to 

change them all the time. 

 

Tools available for CSV files 

 

A .csv file (comma separated values) uses, as the name suggests, a comma to separate the values inside 

it. But since there is no standard for csv files, any separator can be used. 

Right now, in dWValidator we have two separators that can be set to display the file as a table: the 

comma “,” and the semicolon “;”. 

 

 

In case the file is not displayed correct (only one column is shown) or a warning message appears, you 

need to change the delimiter that is used. 
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Tools available for METS 

 

The METS viewer has its own set of actions on Toolbox. 

 

Show metadata panel will bring up a new panel inside the Mets viewer, where a node’s linked metadata 

is displayed.  
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When displaying articles as ALTO, you can see the zones order inside the article by enabling Show zones 

order button. 

 

Depending on the representations available for each METS node, one or more buttons are available to 

select how to display the node.  

The representations available are: 

- ALTO – shows the zones of the node displayed over the image 
- IMAGE – shows the image linked to the node 
- TEXT – shows the text file linked to the node 
- PDF – shows the PDF file linked to the node 
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Another toolbar is available for METS files and is displayed inside the central panel.  

 

The buttons on this toolbar can be used to navigate through the files of a representation, display 

multiple files at the same time, or perform zoom actions on the images. 

When viewing more than one file for a Mets node (for example, an article spread on two pages), the 

zoom actions are applied to the selected panel. This is highlighted with a thicker border of the panel. 
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Tools available for Calendar 
 

 

You can choose whether or not to draw the lines that delimit the days of the month (vertical lines) and 

the edges of the calendar. 

You can customize the color of the lines that delimit the days of the month. 

You can customize the background and text colors for the part where the month and year names are 

displayed. There is also the option to display them in the UPPER CASE. 

The first day of the week can be changed and the calendar will be updated according to the selection. 

You can customize the background and text colors for the part where the name of week days is 

displayed. 

You can customize the background color for the days of the month. 

You can choose different colors for the days of the displayed month and those outside the month. 

You can choose the background color for days that contain one issue, multiple issues, missing issues and 

mixed issues (missing and multiple issues) 
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Options 
In TOOLS menu there is the Options entry that opens the dWValidator Options window. 

 

The options window has three tabs:  

- User – for more details, see User settings Help. 

- View managers – for more details, see View manager settings Help. 

- Email notification – for more details, see Email notification Help. 

- Cache settings – for more details, see Cache settings Help. 

Only View managers settings can be changed even if you are not logged in. For Users and Email 

notification you need special rights to change them. For more details, see User rights Help. 
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User settings 

 

The Users settings tab contains a list with all the users of the application and their access level (group). 

In the bottom part the rights of the selected user are displayed. If you do not have an administrator 

account, you will see the Add, Edit, Remove and Change password buttons disabled. 

 

Add / Edit users 
As administrator, you can add, edit and remove users. To add a new user, use Add button that will open 

a new window where you can fill the necessary information of the new user. 
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In the top part of the window, you need to fill the username, the password, the password confirmation 

and an email address2. In case there is a mismatch between the passwords, you will not be able to save 

the new user.  

In the middle part you can select the user group: 

• Standard – the standard user can only perform Manual QA 

• Administrator – the administrator user has all the rights available, including the right to alter or 

add users. 

The bottom part becomes active if Custom group is selected. Here you can select only the desired rights 

for the new user or add / remove rights for existing users. 

                                                           
2 The email address is required only if the user has Can receive mail notification right enabled. 
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The users must have at least one right selected, otherwise you will not be allowed to save the changes 

for that user.  

Changing the password for a user 
The users have the possibility to change their own passwords once they are logged in (for more details, 

see Changing your password Help). But in case a user forgets his password, as administrator, you can 

reset the password for that user. Select the user from the Users list and press Change password. This 

will open a dialog where you can add a new password for the user: 

 

 

User rights 
When a new user is created, he / she can have different levels of access across the applications. The user 

rights available are: 

- Can perform manual QA 

o Allows user to open a batch in manual QA mode (dWValidator) 

o User can generate reports (dWValidator) 

- Can receive mail notification  

o If this right is checked, the user will require an email address to receive notifications 

- Can change settings in project configuration 

o This right allows user to modify the configuration for projects (Configuration Manager) 



dWValidator Help  53 

 
 

- Can import batches 

o Allows the user to import batches (Control Center) 

o Allows the user to re-validate a document / batch (Validator) 

o Allows the user to delete batches (Validator) 

- Can accept or reject batches 

o Allows the user to modify the status of a batch (dWValidator) 

- Can add new users or edit existing ones 

o Allows the user to create new users or modify existing ones (dWValidator). 

Without being logged in, a user is restricted in UI:  

- In Configuration Manager, the user can only view the settings of projects, but cannot modify 

anything. 

- In dWValidator, the user can open batches but not in Manual QA mode and can only view the 

reports and statistics. 
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User rights matrix 

  dWValidator Configuration Manager Control Center 

Can perform manual QA yes no no 

Can receive mail notification yes no no 

Can change settings in project 
configuration 

no yes no 

Can import batches Yes no yes 

Can accept or reject batches Yes no no 

Can add new users or edit 
existing ones 

Yes no no 
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View manager settings 

 

This tab contains two lists: one with all the view managers available in dWValidator and one with all the 

views available for the selected view manager. In the bottom part of the window is displayed a 

description for the selected view manager. 

In this tab you can disable the views that you are not interested in when using dWValidator. For 

example, if you perform manual QA, you can disable the reports and statistics view to focus only on the 

files that you have to check.  

 

All changes made for view managers will be saved in a file in TEMP folder, and will be used next time 

when you’ll use dWValidator. 
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ViewManagerCalendar is now available in ViewManagers list.  

You can enable the check box Calendar only with special configuration done on project level. For more 

details, see ViewManagerCalendar. 

 

Once you’ve made a change in View manager settings, you need to reset the view in order for the 

change to be applied. To do this, use Reset view option from VIEW menu: 

 

The reports and statistics views displayed at batch / document / docblock level do not have entries in 

Settings. 
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Email notification 
Email Notification System is used to send emails to Validator users whenever a batch validation is 

completed. Only users that have Can receive mail notification right will receive the emails. 

 

In this tab, you need to fill the details of an account that will send the email notifications. 

- Email account – the account that will be used to connect to the server and send the emails 

- Password – the password of the account 

- Email server – the mail server used 

- Port – the mail server port to connect (by default, is set to 25). 

As specified on the tab, only users of Administrators group can change these settings. 
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Cache settings 
dWValidator creates for each image a low-resolution copy of the image – this makes the loading much 

faster and the full-size image is only loaded when it is really needed (for actions like zooming in, using 

the color picker or opening the magnifier). These copies of images are stored either locally, in the user 

temporary folder, or on a shared storage, from where they can be used by other users. 

Cache settings are only available when the low-resolution images are stored locally. In case a shared 

location is used, the settings will be disabled. 

 

In this tab, you can: 

- Select the maximum storage space allocated for dWValidator to keep the temporary files. The 

control is restricted between 512 Mb and 10 Gb of space. 

- Select the cache percentage that will be cleared (for more details, see Cache clearing Help).   
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Validation results 
Each node from tree will have four tabs of reports and statistics: 

- Two for automatic tests 

- Two for manual tests. 

All four tabs are automatically open, but you can close the ones that you are not interested in or dock 

them as you like (for more details, see The interface Help).  

Depending on the node you select, you can see the results for the entire batch, a document, a docblock 

or a file.  

 

Automatic tests results 
The two views you can use to check the automatic tests results are Validation report and Statistics.  

 

 

Validation report 
The validation report is a HTML report, in which all the tests and their results are displayed, having the 

font color set based on the test result. 
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The top part of a validation report displays its details: 

- The name of the file / docblock / document / batch you selected 

- Its status (passed / failed) 

- The date when it was generated 

- A “navigation” bar, that you can use to see specific results. This is only available for batch and 

document levels. 

 

In the screenshot above, document A2_19440310_01 was validated on 24/08/2016 and it failed at least 

one test. 

Click on All Errors from the navigation bar to see the tests that failed and on which files, or select a 

docblock to see the results only for the files of that docblock. 
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You can check what the colors of the font represent, by hovering the question mark (?) from the right 

side. It will display a legend with the description of each color. 

 

Statistics  
The Statistics view consist in a pie chart that displays, depending on the level you are checking: 

- The number of Tested documents vs Not tested documents and number of Valid documents vs. 

Invalid documents (at batch level) 

- The number of Passed tests vs Failed tests (at document, docblock and file level) 

 

For all the pie charts that display Passed tests vs. Failed tests, the tests that passed are all grouped 

under “OK”. An entry is added for each failed test, with the number of files that failed that test. 
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In the screenshot above, on the document were performed a total of 27 tests: 

- 21 were successful 

- 6 failed “Check number of layers”  

 

Manual tests results 
There are also two views for displaying manual QA results: Manual QA report and Manual QA statistics. 

 

 

Manual QA report 
The validation report is also a HTML report, in which all the tests and their results are displayed, having 

the font color set based on the test result. 

The report has the same structure as the report for Automatic validation (see Validation report Help), 

the only differences being some extra columns in the report (Checked by, Checked on Machine, Status) 

and the font colors. You can check the legend to see the significance of each color: 
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Manual QA statistics 
This view shows a pie chart, in which the manual QA test results are displayed. The chart can have a 

maximum of six entries: 

- OK 

- For review 

- Major error 

- Minor error 

- Visited 

- Not visited 

 

In the example above, there were 18 tests to perform on that document. From these, 6 were OK, 2 

Major error, 1 for Review, 1 Visited and 8 Not visited. 

  



dWValidator Help  64 

 
 

View managers 
A View manager is an internal structure of dWValidator, which tells the application how to display the 

files of the docblock. Each View manager has different views, defined specifically for a certain file type. 

For all the selected nodes, four additional views are displayed (beside the standard views of the View 

manager): two reports views and two statistics view. For more details, see Validation results Help. 

 

ViewManagerImage 
This is used to display all supported image types: *.jpeg, *.jpg, *.bmp, *.png, *.ico, *.tif, *.jp2, *.cr2, 

*.gif.  

When selecting an image in tree, it will be displayed using the Image view tab: 
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Thumbnail view 
Each docblock configured to use ViewManagerImage will have a special view, displayed when selecting 

the docblock in the Explorer tree. 

 

In this view, all content of the docblock (the images) are displayed, using either their thumbnail (if the 

images have this embedded), or the low-resolution copy of the images. 
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ViewManagerAlto 
This was designed specifically for ALTO files. Because ALTO files contain the coordinates of the zones 

and words, this View manager is used to display them also visually, using the image linked in the ALTO 

file.  

There are six views displayed for an ALTO file by default: 

XML View – displays the content of the file as an xml: 
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Blocks view – using the coordinates and types of the zones from the ALTO, the zones are displayed over 

the linked image (for more details, see Special cases Help): 

 

Words view – using the coordinates of each word from the ALTO file, each word is displayed over the 

linked image (for more details, see Special cases Help): 
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Articles view – it uses the ALTO file content and also the METS file to display the articles on the linked 

image (for more details, see Special cases Help): 

 

ALTO content – displays only the text of the file, using the nodes content of the xml to split the text in 

lines and paragraphs. 
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Text and image view – that splits the ALTO content by lines and adds each line of text as one row of a 

table. For each line, its corresponding image area is displayed, and also the zone ID from ALTO. 

The entire image is displayed on the top part of the list (for more details, see Special cases Help). 

 

 

Special cases 
Articles view 

The Articles view needs a custom procedure that returns the relative path of the METS file. By default, 

we do not provide a solution, so the articles will not be displayed over the image. The procedure needs 

to be added in ***PROJECT_CFG***\ProjectName\CSScripts\interfaceScript.cs file (uses C# language). 

Uncomment the GetMETSRelativePathForALTOArticlesView procedure, and add your code there. 

Example: 

public override string GetMETSRelativePathForALTOArticlesView(string ALTOFileFullPath) 
{ 
 string ALTOFolder = ALTOFileFullPath.Substring(0, ALTOFileFullPath.LastIndexOf('\\')); 
       string documentFolder = ALTOFolder.Substring(0, ALTOFolder.LastIndexOf('\\')); 
       string documentName = documentFolder.Substring(documentFolder.LastIndexOf('\\')+1); 
 return "../" + documentName + "-METS.xml"; 
} 
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The example above returns the relative path of a METS file, located in the main document folder, and 

has the same name as the document, plus “-METS.xml”. 

It is possible to have NO IMAGE FOUND displayed in all the views that require an image. This means that 

the relative path of the linked image is not correct, not pointing to the correct image or even missing 

completely.  

Our standard solution resolves the linking of images with relative path defined like this: 

<fileName>../MASTER/00001.tif</fileName> 

For other cases, a custom procedure is needed to define the path of the image. The custom procedure is 

in ***PROJECT_CFG***\ProjectName\CSScripts\interfaceScript.cs file. Uncomment the 

GetImageRelativePathForALTOView procedure and add your code there. 

Example: 

public override string GetImageRelativePathForALTOView(string ALTOFileFullPath, string 
sourceImageFileName) 
{ 

return "../MASTER/" + sourceImageFileName; 
} 

 

The example above returns our standard relative path: ../MASTER/imageName. 

Other procedures are also available in the same file, that you can overwrite with your own code. You 

can overwrite GetArticlesFromMetsForALTOView procedure if you have a custom METS file. 

Text and image view 

By default, we display all the zones of the ALTO file in this view. You can overwrite the 

GetALTOBlocksIDsToDisplay found in ***PROJECT_CFG***\ProjectName\CSScripts\interfaceScript.cs 

file to return only the desired zone IDs. 
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ViewManagerMets 
This is used specifically for METS files. Because the structure of a METS file is very complex, there is a 

configuration file where you can set what and how to be displayed. The configuration file is located at 
***PROJECT_CFG***\ProjectName\CSScripts\MetsConfig.xml and the default version is: 

<METSViewerCfg> 
 <structFilter> 
      <div label="#TYPE - #ORDER - #LABEL">section</div> 
      <div label="#TYPE - #ORDER - #LABEL">article</div> 
      <div label="#TYPE - #LABEL">issue</div> 
     <div label="#TYPE - #ORDER - #LABEL">chapter</div> 
      <div label="#TYPE - #ORDER">page</div> 
 </structFilter> 
<finalDiv> 
  <div color="#ffff00">text</div> 
  <div color="#80ffff">title</div> 
  <div color="#008000">image</div> 
  <div color="#80ff80">caption</div> 
  <div color="#ffaaff">table</div> 
 </finalDiv> 
</METSViewerCfg> 

 

Inside <structFilter> node you can define the div nodes types that will appear in the Mets viewer tree. 

Their attribute “label” represents how the node will be displayed, based on the attributes of the 

selected div node.  

By default, the structures filtered via in METSConfig.xml are not displayed recursivelly, unless these are 
the last level in tree. This avoids following situations: 
 
1. Press on logical structure node and load all pages for the entire document and highlight the entire 
document. 
2. Press on a Section and highlight the entire content that could spread on multiple pages, etc. 
 
Nevertheless there are cases when recursive display may be useful for example when selecting an 
Article that have also an Illustration bellow in METS tree - the user would like to see complete article 
highlighted as well, even is not final level in tree. 
 
In this case into METSConfig.xml, article node should be configured as follows: 
 
<structFilter> 
  <div label="#TYPE - #ORDER - #LABEL">section</div> 
  <div label="#TYPE - #ORDER - #LABEL" showRecursive="1">article</div> 
  <div label="#TYPE - #ORDER - #LABEL">illustration</div> 
</structFilter> 

 
Based on this configuration, articles will be always highlighted complete, no matter there are Illustation 
nodes inside or not. 
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The nodes inside <finalDiv> are used to define the colors of the areas displayed on Mets viewer.  
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ViewManagerXML 
This is used to display any type of .xml file and is also used in ViewManagerAlto, to display the ALTO file 

as XML. 
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ViewManagerPDF 
It uses Adobe® Acrobat® Reader® and Internet Explorer® to display the PDF inside the application. If you 

don’t have Acrobat Reader® installed, the PDF will need to be downloaded locally and opened in an 

external application. Having Acrobat Reader® installed will also give you access to its tools, so you can 

zoom, search text or print the PDF from inside the application. 
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ViewManagerRtf 
This is used to display *.rtf, *.doc and *.txt files. The contents of the files will be displayed in a Rich Text 

Box view – it behaves the same as WordPad application. This view manager is also used in 

ViewManagerAlto to display the ALTO as text.  

 

There is also a Text-To-Speech functionality, with only English as supported language. On the toolbox is 

the Speak button you can use to start the reading of the file content. A Stop button is displayed once 

the reading is started, so you can stop this process. 
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ViewManagerWeb 
This View manager uses Internet Explorer® to display *.htm and *.html files. The styling of the HTML is 

kept and displayed if it was done either with embedded css and images, or the linked files are found at 

the location where the link is pointing. 

 

The Web View manager is also used in ViewManagerPDF to display the PDF file. 
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ViewManagerGeneric 
This view manager can be used to display any type of file as binary.  
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ViewManagerCSVandExcel 
You can use this view manager to display *.csv, *.xsl and *.xslx files. For .csv files there is an option to 

change the delimiter – by default, it is set to semicolon “;”. 

The Table view behaves like a read-only Excel sheet – you can select individual cells, multiple cells or 

rows, you can resize column width or row height and can sort by clicking on column headers. Using 

CTRL+C will copy the content of the selected cell(s) which then you can paste in an Excel sheet. 
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ViewManagerEpub 
You can use this view manager to display *.epub files. The Epub view contains a tree with the table of 

contents on the left side and the content on the book on the right side.  
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ViewManagerCalendar 

 

This view manager can be used to display calendar view having all days from all the issues from the 

batch highlighted. 

You can configure dWValidator to display a Calendar view for a selected batch. To do this, you need 
custom scripting, which is done in ***PROJECT_CFG***\ProjectName\CSScripts\interfaceScript.cs file 
(uses C# as language). 
 
First, you need to define a class derived from Scripting.CalendarInterface. The methods of this 
interface are called for every document of the selected batch, and all of them receive as input the 
document path. 
For optimization purposes, the bool LoadDocument(string documentPath) method can be used 

to load the document files only once, save them in your custom implemented class, and use them in the 

other methods, ignoring the documentPath argument. 

 

There are a few procedures that you need to add to your custom class:  
 
public override bool LoadDocument(string documentPath) 

Tip: Load the files (XML and others) and save them as members in your class, to avoid loading them 
in the other methods. 
This procedure loads the necessary files needed for extracting information such as issue date, title, 
etc.  
 

public override bool IsMissingIssue(string documentPath) 

This procedure returns true if the document is marked as having a missing issue. 

public override DateTime? GetIssueDate(string documentPath) 

This procedure returns the issue date, or null if there is no issue date. 
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public override string GetIssueTitle(string documentPath) 

This procedure returns the issue title. 

public override string GetIssueAcronym(string documentPath) 
 

This procedure returns the issue acronym. 

public override string GetIssueNumber(string documentPath) 

This procedure returns the issue number. 

public override string GetEditionNumber(string documentPath) 

This procedure returns the edition number. 

public override string GetVolumeNumber(string documentPath) 

       This procedure returns the volume number. 

 

Generate batch reports 
If you want to have the reports of the validation and manual QA processes outside dWValidator, you can 

generate them using Reports option from TOOLS menu.  

 

You need to be logged in and have a batch opened in order to generate reports, otherwise the Reports 

option will be disabled. 

A dialog will be displayed where you can configure the path where you want to save the reports and the 

reports type that will be generated. 



dWValidator Help  82 

 
 

 

The Save settings button will save your options, so you don’t have to change them each time you want 

to generate a report. 

You have the possibility to add in the reports all the results of the validation, checking All test results, or 
only the validation results for failed tests (automatic and manual), checking Only errors. 

Also, for PDF, CSV and Excel reports you can choose to create only one file for the entire batch, using 
One file report check.  

You can also remove user details (columns “Checked by” and “Checked on machine”) from Manual QA 
reports by checking Hide user details. 

For PDF reports, the screenshots attached to Manual QA tests can be embed as images and will appear 
inside the report file. This can help you see directly the problems found during the MQA process but will 
also increase the size of the PDF file on disk. 

Because we use a standard font when creating a PDF file, some characters might not be displayed (for 
example: Chinese characters). You have the option to embed your own font using Embed font check and 
providing the path of the font.  
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Use Generate reports button to export the report. This will create a folder for each report type you 

select. Each folder will contain another folder named after the project name and time stamp.  

 

A zip file will also be created, containing all the files of the folder compressed.  
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Project reports and statistics 
You can view a summary report of any project by using Project reports and statistics button from the 

main toolbar. 

 

The button will open a dialog where you can select the desired project and view a summary report of 

the batches and statistics. 

The report view shows all the batches of the selected project, with details about their status, number of 

documents, number of files. 

 

 

 

 

Project reports and statistics button can be disabled for two reasons: either you are not logged 

in, or your user account doesn’t have the necessary right to modify configuration. For more 

details, see Users rights Help. 
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In statistics tab is displayed a pie chart representing the status of the bathes.  
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Batch status 
A batch can have different statuses (like Explored, Validated …), but the application doesn’t set as status 

Accepted or Rejected. Setting the acceptance of a batch has to be a human decision. 

To manually change the status of a batch, use Change batch status button from the main toolbar. 

 

This will open a dialog where you can select a status: 

 

The default status will be Pending, but you can select  if you consider the batch to be correct, 

or  if you want to reject the batch. 

The batch status will then be updated in database, and will appear in project reports. 

Change batch status button can be disabled for two reasons: either you are not logged in, or your 

user account doesn’t have the necessary right to modify configuration. For more details, see Users 

rights Help. 
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You always have the possibility to set the batch to its previous status by opening again the dialog and 

selecting . 

In order to be able to change a batch status, its current status has to be Validated. Otherwise, the 

buttons for a different status will be disabled. 

 

 


